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Technical Support
Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. TheTechnical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, theTechnical Support groupworkswithProductEngineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right
amount of service for any size organization

■ Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers software upgrades

■ Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site
at the following URL:

www.symantec.com/business/support/index.jsp

All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/contact_techsupp_static.jsp

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer onwhich theproblemoccurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

http://www.symantec.com/business/support/index.jsp
http://www.symantec.com/business/support/contact_techsupp_static.jsp


■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If yourSymantecproduct requires registrationor a licensekey, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and support contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs or manuals

http://www.symantec.com/business/support/
http://www.symantec.com/business/support/


Support agreement resources
If youwant to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

customercare_apac@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America

About Symantec Connect
Symantec Connect is the peer-to-peer technical community site for Symantec’s
enterprise customers. Participants can connect and share informationwith other
product users, including creating forum posts, articles, videos, downloads, blogs
and suggesting ideas, as well as interact with Symantec product teams and
Technical Support. Content is rated by the community, and members receive
reward points for their contributions.

http://www.symantec.com/connect/storage-management

Documentation
Your feedback on product documentation is important to us. Send suggestions
for improvements and reports on errors or omissions. Include the title and
document version (located on the second page), and chapter and section titles of
the text on which you are reporting. Send feedback to:

doc_feedback@symantec.com

For information regarding the latest HOWTO articles, documentation updates,
or to ask a question regarding product documentation, visit the Storage and
Clustering Documentation forum on Symantec Connect.

https://www-secure.symantec.com/connect/storage-management/
forums/storage-and-clustering-documentation

mailto:customercare_apac@symantec.com
mailto:semea@symantec.com
mailto:supportsolutions@symantec.com
http://www.symantec.com/connect/storage-management
mailto:doc_feedback@symantec.com
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Introducing the Symantec
High Availability Console

This chapter includes the following topics:

■ About the Symantec High Availability Console

■ Supported VMware versions

■ Supported operating systems

About the Symantec High Availability Console
The Symantec High Availability Console enables integration with vSphere Client
and configures access control for vCenter Server users to perform the following
tasks:

■ Install the Symantec High Availability guest components

■ Manage the Symantec High Availability guest components licenses

■ Configure application monitoring

As part of the Symantec High Availability Console installation, the installer
registers the SymantecHighAvailability plugin for VMware vCenter Server. This
plugin is required to view the Symantec High Availability tab, the Symantec High
Availability dashboard and the the Symantec High Availability home page, in the
vSphere Client.

Use the Symantec High Availability tab to configure and control application
monitoring on an individual virtual machine.

Use the Symantec High Availability Dashboard to administer application
monitoring at a VMware datacenter/cluster level.

1Chapter



Use the Symantec High Availability home page to install the Symantec High
Availability guest components and to manage the licenses.

Supported VMware versions
TheSymantecHighAvailability solution currently supports the followingVMware
servers and management clients:

4.1, 4.1 Update 1, 4.1 Update 2VMware ESX Server

4.1, 5.0, 5.0 Update 1 and 5.1 RCVMware ESXi Server

4.1, 4.1 Update 1, 5.0

Note: VMware Fault Tolerance is not supported.

VMware vCenter Server

4.1, 5.0, 5.0 Update 1 and 5.1 RCVMware vSphere Client

Supported operating systems
Table 1-1 lists the operating systems onwhich you can install the Symantec High
Availability Console.

Table 1-1 Supported operating systems for Symantec High Availability Console

Service PackEditionArchitectureServer

SP1 required, SP2
supported

Standard Edition

Enterprise Edition

Datacenter Edition

Web Edition

Small Business Server

x64Windows Server
2008

SP1Standard Edition

Enterprise Edition

Datacenter Edition

Web Edition

x64Windows Server
2008 R2

Introducing the Symantec High Availability Console
Supported VMware versions
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Installing the Symantec
High Availability Console

This chapter includes the following topics:

■ Before installing the Symantec High Availability Console

■ Ports and firewall settings

■ Installing Symantec High Availability Console

Before installing the Symantec High Availability
Console

Consider the followingbefore youproceed to install theSymantecHighAvailability
Console:

■ The installation must be run locally. Remote install is not supported.

■ You can install the Symantec High Availability Console on Windows Server
2008 or Windows Server 2008 R2 servers only.

■ You can install the SymantecHighAvailability Console on a dedicated physical
host or a virtual machine or on the vCenter Server itself. If you wish to
configure availability for theConsole Server itself, youmust install the Console
on a virtual machine.

■ The installer uses the logged-on user account context to perform the
installation. Verify that the logged-on user has local administrator privileges
on the machine where you want to install the server.

■ As part of the Symantec High Availability Console installation, the installer
registers the Symantec High Availability plugin for VMware vCenter Server.
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■ The Symantec High Availability solution supports one Console per vCenter
Server.
To reconfigure the vCenter Server with another instance of Symantec High
Availability Console, you must first uninstall the existing Console and verify
that the plugin is unregistered from the vCenter Server.

Additional requirements
Note the following additional requirements before deploying the Symantec High
Availability solution in your environment:

■ Microsoft Internet Explorer version 6.0 or later

■ Mozilla Firefox 3.x or later

■ Pop-up blockers are not enabled on the machine

■ Toview theHighAvailability tab in the vSphereClient, verify that the following
settings in your Internet Explorer (IE) browser are enabled:

■ Use SSL 2.0

■ Use SSL 3.0

■ Use TLS 1.0

Tools > Internet
Options,Advanced
tab

■ Active scripting

■ Run ActiveX controls and plug-ins

■ Script ActiveX controls marked safe for scripting

Tools > Internet
Options, Security
tab

Shockwave Flash ObjectTools > Manage
Add-ons

■ To view the Symantec High Availability tab on Windows Server 2008 systems
running Internet Explorer (IE) version 9, verify that IE Enhanced Security
Setting is set to "Off" for the Administrator and the Users group.

■ Installation media and licenses for all products and third-party applications.

■ Adobe Flash Player
Install Adobe Flash Player version 11.1 or later on the systems from where
you run the VMware vSphere Client to manage the virtual machines.

■ When installing Symantec HighAvailability Console, ensure that there are no
parallel installations, live updates, orMicrosoftWindowsupdates in progress.

Installing the Symantec High Availability Console
Before installing the Symantec High Availability Console
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Ports and firewall settings
Certain ports and services are used during installation and configuration of the
SymantecHighAvailability Console. If you have configured a firewall, ensure that
the firewall settings allow access to these ports and services.

Table 2-1 displays the services and ports used during the installation and
configuration of the Symantec High Availability Console.

Table 2-1 Services and ports used during the installation and configuration
of the Symantec High Availability Console

DescriptionSettingsPort/ProtocolComponent
Name

Services used during Console server
installation

Used by the installer
to copy the
installation files to the
machine.

Allow inbound and
outbound

File and Printer
Sharing

Used by the installer
to discover virtual
machines.

Allow inbound and
outbound

Windows
Management
Instrumentation
(WMI) service

VMware vCenter Server

Used by the installer
to register High
Availability plugin
and add High
Availability privileges
to the vCenter Server.

Allow inbound and
outbound

443/ https

(Default port)

VMware Web
Service

Ports and services used by Symantec High
Availability Console

13Installing the Symantec High Availability Console
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Table 2-1 Services and ports used during the installation and configuration
of the Symantec High Availability Console (continued)

DescriptionSettingsPort/ProtocolComponent
Name

Used by the High
Availability Console
host to run Java
Servlets that fetch the
application
monitoring status
from the virtual
machines and display
the information on
the High Availability
tab in the vSphere
Client.

Allow inbound and
outbound

14151, 14152/ TCPSymantec High
Availability
Service

Used by the High
AvailabilityConsole to
authenticate the
single sign-onaccount
configured for a
virtual machine.

Allow inbound and
outbound

14153/ TCPSymantec High
Availability
Authentication
Service

Used by the High
AvailabilityConsole to
read and update the
Sybase database.

Allow inbound and
outbound

14154/ TCPSymantec
ApplicationHA
Database Service

Used for
communications
between the High
Availability Console
host machine and the
virtual machines.

Allow inbound and
outbound

5634 / TCPVeritas Storage
Foundation
Messaging Service
(xprtld)

Installing Symantec High Availability Console
Use the product installer to install the SymantecHighAvailability Console in your
VMware virtualization environment.

Installing the Symantec High Availability Console
Installing Symantec High Availability Console
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To install High Availability Console using the installation wizard

1 From the machine identified to serve as the Symantec High Availability
Console, navigate to the software package directory and run Setup.exe to
launch the installer.

2 On the product installer, click Install/UpgradeConsoleServerComponents
under Symantec High Availability Console to launch the installation wizard.

3 Review the prerequisites on the Welcome panel and then click Next.

Note that the Check for product updates check box is selected by default.
The product installer searches for the available product updates on the SORT
website. If you do not want to apply the available patches, clear the selection
of Check for product updates check box.

You can download and apply the available updates.

4 On the License panel, read the Symantec Software License Agreement, select
I accept the terms of License Agreement, and then click Next.

The Participate in the Symantec Product Improvement Program by
submittingsystemandusageinformationanonymously checkbox is selected
by default. The Product Improvement Program allows the product installer
to collect installation, deployment, andusage data and submit it anonymously
to Symantec. The collected information helps identify how customers deploy
and use the product. If you do not want to participate in the product
improvement program, clear the selection of the check box.

5 On the Product Updates panel, review the list of available product updates.

This panel appears only if you have selected the Check for product updates
check box on the Welcome panel.

Theproductupdates comprise of thepre-installationpatches, post-installation
patches, High Availability Agents, and Array-Specific Modules. The panel
lists the available pre-installation patches and the post-installation patches.
Download and apply the pre-installation patches in the sequence shown in
the table and the re-run the wizard. After the successful installation of the
product, apply the post-installation patches. Also download and install the
HighAvailabilityAgents andArray-SpecificModules from the SORTwebsite.

15Installing the Symantec High Availability Console
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6 On the vCenter Details panel, specify the vCenter Server details and then
click Next.

Provide the following details:

Select the IP address of the local system from the drop-down list.

This is the IP of the machine where you will install the High
Availability Console.

The drop-down list may display several IPs if the system has
multiple network adapters each with a unique IP address
assigned.

Select the host IP address that is accessible from the vCenter
Server.

Symantec High
Availability
Console IP

Specify the fully qualified host nameor IP address of theVMware
vCenter Server.

Ensure that the specified vCenter Server host name or IP address
is accessible from the machine where you are installing the
Symantec High Availability Console.

vCenter Server
FQHN or IP

Specify the https port used by the VMware Web Service.

The default port number is 443.

Web Service Https
Port

Specify the name of the user account that has the privileges to
extend the vSphere Client.

The installer uses this account to register the Symantec High
Availability plugin on the vCenter Server.

User Name

Specify the password for the user account specified in the User
Name field.

Password

7 On the System Validation panel, the installer automatically selects the local
host for installation and begins verification.

After the status shows as Ready for Install, click Next.

The wizard uses %Program Files%\Veritas as the default installation
directory. To change the directory, click the folder icon next to the system
and then choose the installation directory.

The wizard performs validation checks on the machine. If the machine does
not meet the required criteria, the status is reflected as Verification failed.
To view the cause of a validation failure, click the Information icon. Rectify
the issue and then click Re-verify to perform the validation checks again.

The wizard does not proceed unless the system passes the validation checks.

Installing the Symantec High Availability Console
Installing Symantec High Availability Console
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8 On the Pre-install Summary panel, review the pre-installation summary and
then click Next.

Click Save Report if you wish to save the pre-installation summary report
for reference.

9 The Installation panel displays the installation progress.

After the panel indicates that the installation is complete, click Next.

10 On the Post-install Summary panel, review the installation results and then
click Next.

Thewizard configures the required services and registers theSymantecHigh
Availability plugin on the specified vCenter Server.

If the installation has failed on the system, review the post-install summary
report and refer to the wizard log file for details.

The log file is located at
%AllUsersProfile%\Veritas\VPI\log\<date_timestamp>.

Youmayhave to repeat the installation if thewizard indicates that the install
has failed.

If the logs indicate that the Symantec High Availability plugin registration
has failed, you may have to manually register the plugin on the vCenter
Server. Use the PluginMgmt.bat utility to register the plugin.

See “About the Symantec High Availability plugin registration or
unregistration issues” on page 35.

11 On the Finish panel click Finish.

This completes the installation of Symantec High Availability Console.

Note:TheVeritasOperationsManager-ManagedHost (VOMMH) components
are also installed alongwith the Console Server components.

17Installing the Symantec High Availability Console
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12 This step is applicable only if youhave re-installed SymantecHighAvailability
Console in your monitoring environment.

After completing the installation, the Symantec High Availability tab may
fail to retrieve the application status. In such a case, you may have to close
the Symantec High Availability tab and open it again.

In the vSphere Client, click another virtual machine, then click the original
virtual machine again and then select the Symantec High Availability tab, or
exit the vSphere Client and launch it again.

TheSymantecHighAvailability view thendisplays the status of the configured
applications on the virtual machine.

The Symantec High Availability dashboard also displays the status of the
configuredapplicationson thevirtualmachine, and theother virtualmachines
under Symantec High Availability control in the same cluster or data center.

Installing the Symantec High Availability Console
Installing Symantec High Availability Console
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Administering the
Symantec High Availability
Console installation

This chapter includes the following topics:

■ Upgrading the Console Server

■ Repairing the Symantec High Availability Console installation

■ Uninstalling Symantec High Availability Console

Upgrading the Console Server
Use the SymantecHighAvailability product installer to upgrade the Console. You
can upgrade the Console on local machine only. After upgrade, the updated
Symantec High Availability plugin is registered on the vCenter Server.

When upgrading the Console Server, ensure that the Symantec ApplictionHA
Console Server version 5.1 SP2 or 6.0 is installed. If your current installation does
not meet the minimum level required by the installer, you must manually apply
the appropriate upgrades to meet the minimum level required before proceeding
with the installer. You can get the intermediate versions on the Symantec Support
site.

Note: In case the Console upgrade process fails, you must uninstall the Console
and then reinstall it.

See “Uninstalling Symantec High Availability Console” on page 25.
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To upgrade the Console Server

1 From the system where you want to upgrade the Console Server, navigate to
the software package directory and run Setup.exe to launch the installer.

2 On the Symantec High Availability Installer, click Install Console Server
Components under Symantec High Availability Console to launch the
installation wizard.

3 Review the prerequisites on the Welcome panel and then click Next.

4 On the License Agreement panel, read the Symantec Software License
Agreement, select I accept the terms of License Agreement, and then click
Next.

Administering the Symantec High Availability Console installation
Upgrading the Console Server
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5 On the vCenter Details panel, specify the vCenter Server details and then
click Next.

Provide the following details:

Select the IP address of the local system from the drop-down
list.

This is the IP of the machine where you will install the
Console.

The drop-down list may display several IPs if the system has
multiple network adapters each with a unique IP address
assigned.

Select the host IP address that was used during the previous
installation. This IP address must be accessible from the
vCenter Server.

Symantec High
Availability Console
IP

Specify the fully qualified host name or IP address of the
VMware vCenter Server.

Ensure that the specified vCenter Server FQHN or IP address
is the same as that specified during the previous installation.
This FQHNor IP addressmust be accessible from themachine
where you are installing SymantecHighAvailability Console.

vCenter Server FQHN
or IP

Specify the https port used by the VMware Web Service.

The default port number is 443.

Web Service Https
Port

Specify the name of the user account that has the privileges
to extend the vSphere Client.

The installer uses this account to register the updated
Symantec High Availability plugin on the vCenter Server.

User Name

Specify the password for the user account specified in the
User Name field.

Password

21Administering the Symantec High Availability Console installation
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6 On the System Validation panel, the installer automatically selects the local
host for installation and begins the validation checks.

After the status shows as Ready for Upgrade, click Next.

The installation directory used during the previous installation is selected
by default. You cannot customize the installation directory location.

If the system does not meet the required criteria, the status is reflected as
"Verification failed". To view the cause of a validation failure, click the
Information icon. Rectify the issue and then click Re-verify to perform the
validation checks again. The wizard does not proceed unless the system has
passed the validation checks.

7 On the Pre-install Summary panel, review the pre-installation summary and
then click Next.

Click Save Report if you wish to save the pre-installation summary report
for reference.

8 On the Stop Services panel, review the status of services getting stopped.

If a service fails to stop, clickRetry to initiate the process again. If the service
again fails to stop, run the following commands tomanually stop the service:

CommandService

net stop “ApplicationHA Server Server”Symantec High Availability
service

net stop “AppHASecD”Symantec High Availability
Authentication Service

net stop “SQLANYe_ApplicationHAdb”Symantec High Availability
Database Service

9 The Installation panel displays the installation progress. After the panel
indicates that the installation is complete, click Next.

Administering the Symantec High Availability Console installation
Upgrading the Console Server
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10 On the Post-install Summary panel, review the installation results and then
click Next.

The wizard configures the required services and registers the updated
Symantec High Availability plugin on the specified vCenter Server.

If the installation has failed, review the post-install summary report and refer
to the wizard log file for details.

The log file is located at

%AllUsersProfile%\Veritas\VPI\log\<date_timestamp>.

If the logs indicate that the Symantec High Availability plugin registration
has failed, you may have to manually register the plugin on the vCenter
Server. Use the PluginMgmt.bat utility to register the plugin.

11 On the Finish panel click Finish.

This completes the Console Server upgrade.

Repairing the Symantec High Availability Console
installation

Use the Symantec High Availability installer to repair the Symantec High
Availability Console installation in your VMware virtualization environment.

Repairing the installation restores the server installation to its original state.
Repairing fixes missing or corrupt files, shortcuts, and registry entries on the
local system.

Note: You can repair the Symantec High Availability Console installation on the
local system only. Repairing an installation remotely is not supported.

Consider the following points before you proceed:

■ If you have configured applicationmonitoring for SymantecHighAvailability
Console itself, then you must unconfigure the same before repairing the
installation. After the installation repair is complete, you must reconfigure it
again.

■ While the installer is repairing the Console installation, then the Symantec
High Availability view and the Symantec High Availability dashboard in the
vSphere Client may not display the most current status of the applications
configured on the virtual machines.
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■ The installer uses the logged-on user account context to perform the repair.
Verify that the logged-on user has local administrator privileges on the system
where you want to repair the installation.

■ After the repair completes successfully, youmayhave to register the Symantec
High Availability plugin on the VMware vCenter Server again.
For details refer to:
See “About theSymantecHighAvailability plugin registrationorunregistration
issues” on page 35.

To repair the Symantec High Availability Console installation

1 On the Symantec High Availability Console system openWindows Programs
and Features.

Click Start > Settings > Control Panel and then double-click Programs and
Features.

2 Select Symantec High Availability 6.0.1 Console in the programs list and
then click Change to launch the installer.

3 On the Mode Selection panel, click Repair and then click Next.

4 Click OK on the dialog box that prompts you to repair the Veritas Operations
Manager (Host Component). This does not begin to repair the VOM
installation.

Refer to VOM documentation for more information.

5 On the System Validation panel the installer automatically selects the local
system for repair and begins the validation checks. After the status shows as
Ready for repair, click Next.

You can repair the installation on the local system only.

If the system does not meet the required criteria, the status is reflected as
"Verification failed". To view the cause of a validation failure, click the
Information icon. Rectify the issue and then click Re-verify to perform the
validation checks again.

The wizard does not proceed with the repair unless the system has passed
the validation checks.

6 On the Pre-install Summary panel, review the pre-update summary and then
click Next.

Click Save Report if you wish to save the summary report for reference.

7 The Installation panel displays the installation progress. After the panel
indicates that the installation is complete, click Next.
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8 On the Post-install Summary panel, review the installation results and then
click Next.

If the installation has failed, review the post-install summary report and refer
to the wizard log file for details.

The log file is located at
%AllUsersProfile%\Veritas\VPI\log\<date_timestamp>.

You may have to repeat the installation repair in case the installation fails.

9 On the Finish panel click Finish.

This completes the Symantec High Availability Console installation repair.

10 If you have configured application monitoring for the Console itself, then
start the Veritas High Availability Engine service on the Symantec High
Availability Console host.

To start the Veritas High Availability Engine service type the following
command on the command prompt:

hastart

11 After performing the repair, the Symantec High Availability tab may fail to
retrieve the application status. In such a case, you may have to close the
Symantec High Availability tab and open it again.

In the vSphere Client, click another virtual machine, then click the original
virtual machine again and then select the Symantec High Availability tab, or
exit the vSphere Client and launch it again. The Symantec High Availability
view then displays the status of the configured applications on the virtual
machine.

The Symantec High Availability dashboard also displays the status of the
configuredapplicationson thevirtualmachine, and theother virtualmachines
that are included in the same cluster or data center.

Uninstalling Symantec High Availability Console
Use the Console server installation wizard to uninstall the Symantec High
Availability Console from your VMware virtualization environment.

Consider the following points before you proceed:

■ As part of the Console uninstallation, the installer also unregisters the
SymantecHighAvailability plugin for vCenter Server. As a result the Symantec
High Availability tab and the Symantec High Availability dashboard will be
removed from the vSphere Client.
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■ If the purpose of the uninstall is to replace the existing server with another
Symantec High Availability Console, then the application status may not be
visible in the vSphere Client until the new server is installed and configured.

■ The uninstallation must run locally. Remote uninstall is not supported.

■ The installer uses the logged-on user account context to perform the
uninstallation.Verify that the logged-onuserhas local administrator privileges
on the system where you want to uninstall.

■ If youhave configuredmonitoring for the Console Server itself, then youmust
unconfigure the same before uninstalling the Console.

■ Veritas Operations Manager binaries are installed as part of the Console
installation. Do not uninstall these binaries before uninstalling the Console
components.

Perform the following steps to uninstall the Symantec High Availability Console.

To uninstall the Symantec High Availability Console

1 OntheSymantecHighAvailabilityConsolehost openWindowsAddorRemove
Programs.

Click Start > Settings > Control Panel and then double-click Programs and
Features.

2 In the Add or Remove Programswindow, select SymantecHighAvailability
6.0.1 Console and then click Uninstall.

This launches the Symantec High Availability installer.

3 Review the prerequisites on the Welcome panel and then click Next.
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4 On the VMware vCenter Server Details panel, specify the vCenter Server
details and then click Next.

Provide the following details:

Specify the host name or IP address of the VMware vCenter
Server.

Ensure that the specified vCenter Server host name or IP address
is accessible from the High Availability Console host.

vCenter Server
Name or IP

Specify the https port used by the VMware Web Service.

The default port number is 443.

Web Service Https
Port

Specify the name of the user account that has the privileges to
extend the vSphere Client.

The installer uses this account to unregister theHighAvailability
plugin on the vCenter Server.

User Name

Specify the password for the user account specified in the User
Name field.

Password

5 On the System Validation panel, the installer automatically selects the local
host for uninstallation and begins verification. After the status shows as
Ready for uninstall, click Next.

If the system does not meet the required criteria, the status is reflected as
Verification failed. To view the cause of a validation failure, click the
Information icon. Rectify the issue and then click Re-verify to perform the
validation checks again.

The wizard does not proceed unless the system passes the validation checks.

6 On the Pre-uninstall Summary panel, review the summary and then click
Next.

Click SaveReport if you wish to save the pre-uninstallation summary report
for reference.

7 The Symantec High Availability Console Un-installation panel displays the
progress of the uninstallation.

After the panel indicates that the uninstallation is complete, click Next.

The installer stops the required services and unregisters the Symantec High
Availability plugin on the vCenter Server.
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8 On thePost-uninstall Summarypanel, review the results and then clickNext.

If the uninstallation has failed, review the post-uninstall summary report
and refer to the wizard log file for details.

The log file is located at
%AllUsersProfile%\Veritas\VPI\log\<date_timestamp>.

You may have to repeat the uninstallation if the wizard indicates that the
installation itself has failed.

If the logs indicate that the SymantecHighAvailability plugin uninstallation
has failed, youmust disable the plugin from the vSphere Clientmenu (Plugins
> Manage Plugins)

9 On the Finish panel click Finish.

This completes the Symantec High Availability Console uninstallation.
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Roles and privileges

This appendix includes the following topics:

■ About the roles and privileges assigned

■ Configuring Symantec High Availability access control

About the roles and privileges assigned
The following set of privileges are available after you install the Symantec High
AvailabilityConsole. Theseprivileges define the operations that auser canperform
on the system. You can create roles and then assign privileges to them or assign
privileges to the existing roles that are available in the vSphere environment.
Application monitoring operations are enabled or disabled depending on the
privileges that are assigned to the vCenter user account. For example, the Admin
privilege is required for configuring application monitoring on a system.

vCenter Server administrators canuse these privileges to configure access control
while monitoring an application.

■ View Application State (Guest)
Can view the application status on the system. The Guest cannot perform any
application monitoring operations.

■ Control Application Availability (Operator)
Can perform all the operations that include start and stop configured
applications, enable anddisable applicationmonitoring, specify the application
monitoring configuration settings, enter and exit application maintenance
mode, and view the application status.
The Operator cannot configure or unconfigure application monitoring on the
system.

■ Configure Application Availability (Admin)

AAppendix



Canperformall operations that include configure andunconfigure application
monitoring, start and stop configured applications, enable and disable
application monitoring, specify the application monitoring configuration
settings, enter and exit application maintenance mode, and view application
status.

ConfiguringSymantecHighAvailability access control
After installing theSymantecHighAvailability solutionyoumaywant to configure
access control for virtual machine users in our environment.

Use the vSphere Client to configure access control and to assign the privileges.
You can either create additional roles or assign these privileges to existing roles
directly.

Refer to the VMware documentation for more details on roles, users, and groups.

To assign Symantec High Availability user privileges

1 From the vSphere Client Home page click Roles.

2 In the Roles list, right-click the role to edit and click Edit Role.

3 In the Edit Role dialog box, expand All Privileges.

You should see the Symantec High Availability privileges in the list.

4 ExpandSymantecHighAvailability privileges and then select the check boxes
of the privilege you want to enable for the role.

5 Click OK.

Roles and privileges
Configuring Symantec High Availability access control

30



Troubleshooting

This appendix includes the following topics:

■ About the installer and Console logging

■ Troubleshooting Console issues

■ Troubleshooting the Symantec High Availability plugin issues

About the installer and Console logging
Symantec High Availability Console installer logs contain details about the
installation tasks and the overall progress status. These logs are useful for
resolving common installation related issues.

The installer creates the log directory as soon as you launch the wizard.

The log file is located at:

%AllUsersProfile%\Veritas\VPI\log\<date_timestamp>\HighAvailability_Console601_Installer_A.log

Here, %AllUsersProfile% is the Windows variable that typically expands to
C:\ProgramData.

To collect the Symantec High Availability Console logs, use the hagetcf utility.
This utility retrieves and writes detailed diagnostic information about the
monitoring configuration. These details are useful for debugging configuration
related issues.

After you install the Symantec High Availability Console the hagetcf utility is
available in the following directory on the Console host:

%ALLUSERPROFILE%\Symantec\ApplicationHA\Logs
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Perform the following steps to collect the Symantec High Availability Console logs

1 On the Symantec High Availability Console host, navigate to the following
directory from the command prompt:

%AllUSERPROFILE%\Symantec\ApplicationHA\Logs

2 Run the hagetcf utility from the directory.

Type the following command:

hagetcf

The hagetcf utility writes the output to
%systemdrive%\hagetcf\mmdd_uniquenumberdirectory.

For example, C:\hagetcf\0819_2316.

The directory contains several folders and log files representing various
components.

Troubleshooting Console issues
This section lists common troubleshooting scenarios that you may encounter
while or after installing the Symantec High Availability Console.

Symantec High Availability Console files become corrupt
If the Symantec High Availability Console files and registry becomes corrupt and
theConsole fails to respond, perform the following to restore andget the Symantec
High Availability Console up and running.

These steps presume that youhad backedup the following directories and registry
from the Symantec High Availability Console host, after configuring application
monitoring on the virtual machines:

■ <installdirectory>\Veritas Shared
Here, <installdirectory> is the directory where you installed the Console,
typically, C:\Program Files\Veritas.

■ %AllUsersProfile%\Symantec\ApplicationHA\sec
%AllUsersProfile%\Symantec\ApplicationHA\conf
Here %AllUsersProfile% typically expands to C:\ProgramData.

■ HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Veritas\VPI

Troubleshooting
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Perform the following steps on the Symantec High Availability Console host:

1 Restore the veritas shared directory that you backed up to the following
location:

<installdirectory>\

Here, <installdirectory> is the directory where you installed the Console,
typically, C:\Program Files\Veritas.

2 FromtheWindows registry editor, restore the followingVPI registry key that
you had backed up earlier:

Perform the following:

■ Click Start > Run, type regedit and then click OK to open the Windows
Registry Editor.

■ Navigate to the following location:
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Veritas

■ Click File > Import and then specify the VPI registry key that you had
backed up earlier and then click Open.

■ After the import is successful, save and close the registry editor.

3 From the Windows Add or Remove Programs, repair Symantec High
Availability Console.

4 After the Console repair completes, stop the following services:

■ Symantec ApplicationHA Authentication Service

■ Symantec ApplicationHA Service

■ Veritas Storage Foundation Messaging Service

5 Restore the sec and conf directories that youbackedup earlier at the following
location:

%AllUsersProfile%\Symantec\ApplicationHA\

%AllUsersProfile%\Symantec\ApplicationHA\

Here %AllUsersProfile% typically expands to C:\ProgramData.

6 Start the services that you stopped in step 5 earlier

7 Exit the vSphere client, launch it again and then log on to the vCenter Server
that manages the virtual machines where you have configured application
monitoring.

8 In the vSphere client Inventory pane, click on a virtual machine where you
have configured application monitoring, and then select the Symantec High
Availability tab to view the status of the applications configured.
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Symantec High Availability Console host becomes permanently
unavailable

If the Symantec High Availability Console host becomes unavailable either due
to a server crash or because you want to set up the Console on a new server
altogether, there are series of steps that youmust performbefore you get the new
Symantec High Availability Console host up and running.

Perform the following steps:

1 Unregister the Symantec High Availability plugin for the vCenter Server.

■ If your existing SymantecHighAvailability Console host is still available,
use the pluginmgmt.bat utility for the operation.

■ If you have lost the existing Symantec High Availability Console host,
unregister the plugin manually, using VMware MOB.

2 Install Symantec High Availability Console on a new system.

3 Exit the vSphere client, launch it again and then log on to the vCenter Server
that manages the virtual machines where you have configured application
monitoring.

4 From the vSphere client Inventory pane, click on a virtual machine where
you have configured application monitoring, select the Symantec High
Availability tab, and then configure thevirtualmachine administrator account
on the new Console host.

5 Repeat step 4 for all the virtual machines where you have configured
application monitoring.

The SymantecHighAvailability tab then displays the status of the configured
applications on the virtual machines.

6 Configure Symantec High Availability user privileges for the vCenter Server
users, if required.

Troubleshooting theSymantecHighAvailability plugin
issues

This section lists common troubleshooting scenarios that you may encounter
while or after registering the Symantec High Availability plugin.
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About the Symantec High Availability plugin registration or
unregistration issues

The Symantec High Availability Plugin for vCenter Server is registered when you
install the Symantec High Availability Console.

You may need to manually unregister and register the plugin in cases where,

■ the plugin registration or unregistration has failed during Symantec High
Availability Console installation or uninstallation, respectively.

■ you wish to change the existing Symantec High Availability Console host, or
if there is a change in the vCenter Web Service port.

The PluginMgmt.bat utility helps you manage the Symantec High Availability
plugin registration in your VMware environment. The utility provides options to
register, unregister, and verify the registration of the plugin on the vCenter Server.

The PluginMgmt.bat utility is available in the following directory on the Console
host:

<installdirectory>\ApplicationHA\bin

Here, <installdirectory> is the directory where you install the Console,
typically,C:\Program Files\Veritas.
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To administer the plugin registration using PluginMgmt.bat

1 From the Symantec High Availability Console host, launch the command
prompt in the Run as Administratormode and then navigate to the following
directory in the command window:

<installdirectory>\ApplicationHA\bin

2 Type the following command to run the pluginmgmt.bat in desired mode:

PluginMgmt <register|unregister|verify> <Symantec High Availability Console_IP>

<vCenterServer_IP> <vCenterServerSDK_Port>

<vCenterServer_Username> <vCenterServer_Password>

The following inputs are required:

Specify register to register the plugin.

Specify unregister to unregister the plugin.

Specify verify to validate the plugin registration.

The PluginMgmt.bat utility performs these operations on
the vCenter Server specified for vCenterServer_IP value.

register | unregister |
verify

If you wish to register the plugin, specify the IP address
of the system where you installed the Symantec High
Availability Console.

If you wish to unregister or verify the plugin, specify the
IP address of the system that is currently running the
Symantec High Availability Console.

Symantec High
Availability Console_IP

Specify the IP address of the vCenter Server used to
manage the virtual machines.

vCenterServer_IP

If youwish to register or verify the plugin, specify the port
used by the VMware Web Service.

If you wish to unregister the plugin, then specify the port
that was used while registering the plugin.

The default port is 443.

vCenterServerSDK_Port

Specify a user account that has the vCenter Extension
privileges on the vCenter Server specified for
vCenterServer_IP value.

vCenterServer_Username

Specify the password of the user account specified for
vCenterServer_Username value.

vCenterServer_Password

The output of the command confirms the status of the requested operation.
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The Symantec High Availability plugin available in the vCenter Server
Plug-in Manager is "Disabled"

This issue typically occurs if the vCenter Server fails to access the SymantecHigh
Availability Console IP, that was used while configuring single sign-on between
the Symantec High Availability Console and the vCenter Server. Since the plugin
is disabled the Symantec High Availability tab and dashboard are not available.

Resolution:

Perform the following steps to resolve the issue

1 Using the PluginMgmt.bat utility unregister the plugin and then register it
again.

While registering the plugin again, specify a Console server IP address that
is accessible over the network from the vCenter Server.

2 On the Console Server, run the following command and then restart the
Symantec High Availability Service.

"c:\Program Files\Veritas\VRTSsfmh\bin\perl.exe" "c:\Program

Files\Veritas\ApplicationHA\bin\create_cert.pl"

AppHAConsoleIP=ConsoleIP

The ConsoleIP is the IP address you specified while registering the plugin
again.
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